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Chapter 3
Constructive Solid Geometry Concepts

Leanming Ojectives

¢ Understand Constructive Solid
Geometry Concepts

¢ Create a Binary Tree

¢ Understand the Basic Boolean
Operations

¢ Set up Grid and Snap Intervals

¢ Understand the Importance of Order of
Features

¢ Create Placed Features

¢ Use the Different Extrusion Options
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Introduction

In the 1980s, one of the main advancements in solid modeling was the development of
the Constructive Solid Geometry (CSG) method. CSG describes the solid model as
combinations of basic three-dimensional shapes (primitive solids). The basic primitive
solid set typically includes Rectangular-prism (Block), Cylinder, Cone, Sphere, and
Torus (Tube). Two solid objects can be combined into one object in various ways using
operations known as Boolean operations. There are three basic Boolean operations:
JOIN (Union), CUT (Difference), and INTERSECT. The JOIN operation combines
the two volumes included in the different solids into a single solid. The CUT operation
subtracts the volume of one solid object from the other solid object. The INTERSECT
operation keeps only the volume common to both solid objects. The CSG method is also
known as the Machinist's Approach, as the method is parallel to machine shop
practices.

Primitive Solids

JOIN INTERSECT

CuUT

’
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Binary Tree

The CSG is also referred to as the method used to store a solid model in the database. The
resulting solid can be easily represented by what is called a binary tree. In a binary tree,
the terminal branches (leaves) are the various primitives that are linked together to make
the final solid object (the root). The binary tree is an effective way to keep track of the
history of the resulting solid. By keeping track of the history, the solid model can be re-
built by re-linking through the binary tree. This provides a convenient way to modify the
model. We can make modifications at the appropriate links in the binary tree and re-link
the rest of the history tree without building a new model.

.~ / Terminal branches

Result

Union

7
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The Locator Design

The CSG concept is one of the important building blocks for feature-based modeling. In
Autodesk Inventor, the CSG concept can be used as a planning tool to determine the
number of features that are needed to construct the model. It is also good practice to
create features that are parallel to the manufacturing process required for the design. With
parametric modeling, we are no longer limited to using only the predefined basic solid
shapes. In fact, any solid features we create in Autodesk Inventor are used as primitive
solids; parametric modeling allows us to maintain full control of the design variables that
are used to describe the features. In this lesson, a more in-depth look at the parametric
modeling procedure is presented. The equivalent CSG operation for each feature is also
illustrated.

» Before going through the tutorial, on your own make a sketch of a CSG binary tree of
the Locator design using only two basic types of primitive solids: cylinder and
rectangular prism. In your sketch, how many Boolean operations will be required to
create the model? What is your choice of the first primitive solid to use, and why?
Take a few minutes to consider these questions and do the preliminary planning by
sketching on a piece of paper. Compare the sketch you make to the CSG binary tree
steps shown on the next page. Note that there are many different possibilities in
combining the basic primitive solids to form the solid model. Even for the simplest
design, it is possible to take several different approaches to creating the same solid
model.
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Modeling Strategy — CSG Binary Tree
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Starting Autodesk Inventor

1. Select the Autodesk Inventor option on the Start menu or select the Autodesk
Inventor icon on the desktop to start Autodesk Inventor. The Autodesk Inventor
main window will appear on the screen.

Parametric-Modeling .. .

2. Select the New File icon with a single click of the
left-mouse-button as shown.

% Every object we construct in a CAD system is measured in units. We should
determine the value of the units within the CAD system before creating the first
geometric entities. For example, in one model, a unit might equal one millimeter of
the real-world object; in another model, a unit might equal an inch. In Autodesk
Inventor, the Choose Template option is used to control how Autodesk Inventor
interprets the coordinate and angle entries.

I Create New File

3. Select the Metric tab as shown below. We will use the
millimeter (mm) setting for this example.

Templates
hd en-Us
English
I Metri
Mold Mesign

4. Inthe New File — Part Template
area, select the Standard(mm).ipt
icon as shown.

¥ Part — Create 2D and 3D objects

Sheet  Sheet Standard Standard
Metal Metal (DIN)ipt (mmlpnt
(DIN).ipt (mm).ipt C:/Users/Public/Do

5. Confirm the Parametric-Modeling
project is activated; note the
Projects button is available to
view/modify the active project.

¥ Assembly — Assemble 2D and 3D components

L HBHEL

Mold Maold  Standard Standard Weldment
Design  Design (DIN).jam (mm).iam

6. Pick Create in the Startup dialog box to accept the selected settings.
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Base Feature

In parametric modeling, the first solid feature is called the base feature, which usually is
the primary shape of the model. Depending upon the design intent, additional features are
added to the base feature.

Some of the considerations involved in selecting the base feature are:

¢ Design intent — Determine the functionality of the design; identify the feature that is
central to the design.

e Order of features — Choose the feature that is the logical base in terms of the order
of features in the design. Consider creating the design using as few features as
possible.

¢ Ease of making modifications — Select a base feature that is more stable and is less
likely to be changed.

LD-EHS- -
File 3D Model  Sketch  An

7 W& ®
Sta.rtb Extrude Revolve %
20 Sketch ™ 3

Sketch
« 2D Sketch (5)

Creates a 2D sketch on a

1. Activate the Start 2D Sketch icon with a single
click of the left-mouse-button.

Maodel

2. Move the cursor over the edge of the XZ Plane in the graphics area. When the XZ
Plane is highlighted, click once with the left-mouse-button to select the Plane as the
sketch plane for the new sketch.

Select plane to create sketch or an existing sketch to edit
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GRID Display Setup

1. Inthe Ribbon toolbar panel, select
[Tools] > [Document Settings].

knspect Tools Manage View  Environments GetStarted  Collaborat

r = - F E,. Customize @ Macros
=R

Links ¥¥] VBA Edit
Application Document Migrate  Autodesk I 'j ror
Options  Settil}gs Settings App Manager '-'{}' Add-Ins

Document Settings

Displays the Document Settings dialog box for the active
document.

2. In the Document Settings dialog box, click on the Sketch tab as shown in the below
figure.

3. Setthe X and Y Snap Spacing to 5 mm.

Part1 Document Settings X

Standard Units = Sketch Modeling Bill of Materials Default Tolerance

2D Sketch —]

3. Set to 5 mm
/ | lay

V4

v ‘5.000 mm % ‘ Major every

Snap Spacing

ﬂ =/ minor lines

4. Change Grid Display to display one major line every & minor lines.

5. Pick OK to exit the
Sketch Settings dialog
box.

» Note that although the
Snap to grid option is
also available, its usage in
parametric modeling is
not recommended.

» On your own, use the dynamic Zoom function to view the grid setup. Refer to Page
2-26 on how to switch on the grid lines display options if necessary.
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» A rectangular block will be first created as the base feature of the Locator design.

6. Click on the rotate-left arrow on the view cube to rotate the
display.

LGOI Annotate  Inspect  Tools  Manage

Q7 O e
7. Switch back to the Sketch tab and _ ’ A Text ~
. Circle  Arc Rectangle
select the Two point rectangle - . - i Ge
command by clicking once with the
¥ Rec?ngle

left-mouse-button.
= Twi

Two Point Rectangle

8. Create a rectangle of arbitrary size by selecting two locations on the screen as shown
below.

Second Corner

AN

& =

i |
\ First Corner

C

9. Inside the graphics window, click once with the
right-mouse-button to bring up the option
menu.

(jﬁ’_’ Project Gem:eirv_)

10. Select OK to end the Rectangle command.

11. Activate the General Dimension
command by clicking once with the left-
mouse-button. The General Dimension
command allows us to quickly create and
modify dimensions.

-
r ’-—-‘ Ly O @ W imag

| |2 = A poi
Dimewsion [ . v \{ 4' E" Point
L1 A S f15 | e M s

General Dimension (D)

Places a dimension in a 2D or 3D sketch.
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12. Inside the graphics window, click once with the right-
mouse-button to bring up the option menu and click
Edit Dimension to turn OFF the editing option while
creating dimensions.

13. The message “Select Geometry to Dimension” is displayed in the Status Bar area at
the bottom of the Autodesk Inventor window. Select the bottom horizontal line by
left-clicking once on the line.

13. Select the bottom

horizontal line as the
geometry to dimension. \

N

100.688

14. Pick a location
below the line to place
the dimension.

14. Move the graphics cursor below the selected line and left-click to place the
dimension. (Note that the value displayed on your screen might be different than what
is shown in the above figure.)

15. On your own, create a vertical size dimension of the sketched rectangle as shown.

100.688

——~

(= Two Point Rectangle

16. Inside the graphics window, click once with the right-
mouse-button to bring up the option menu and click
OK to end the Dimension command.

L‘%" Project Geometry |
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Model Dimensions Format

1. In the Ribbon tabs, select
[Tools] 2> [Document Settings].

nspect Tools Manage View Environments  Get Started  Collaborat

r E‘gl +T 1,_’E| E Customize @ Macros
st

Links Y] VBA Edit
Application Document Migrate  Autodesk I 'j ot
Options  Settil’gs Settings App Manager l{,':' Add-Ins

Document Settings

Displays the Document Settings dialog box for the active
document.

2. Inthe Document Settings dialog box, set the Modeling Dimension Display to
Display as value as shown in the figure.

Part1 Document Settings X .
3. Also set the precision

to no digits after the
decimal point for both

Standard Units  Sketch Modeling  Bill of Materials Default Tolerance

Units

Length Time . . .
millmater v] the linear dimension
Angle Mass and angular dimension
degree v] displays as shown in

the above figure.

Modeling Dimension Display
Linear Dim Display Precision ODiSF’lﬁY as value
0. o ODispIay as name

ODispIay as expression
Angular Dim Display Precision

(@) Display tolerance
() Display precise value

4. Pick OK to exit the Document Settings dialog box.

Modifying the Dimensions of the Sketch

1. Select the height dimension that is to the
right side of the sketch by double-
clicking with the left-mouse-button on the
dimension text.

ZBI}

Edit Dimension : d1 X

20.2598626 mm
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2. In the Edit Dimension window, the current
length of the line is displayed. Enter 50 to
set the selected length of the sketch to 50
millimeters.

-
50l > [v]
3. Click on the Accept icon to accept the

entered value.

20| Edit Dimension: d1

» Autodesk Inventor will now update the profile with the new dimension value.

4. On your own, repeat the above steps and adjust the dimensions so that the sketch
appears as shown below. Also exit the Dimension command.

Repositioning Dimensions

1. Move the cursor near the vertical dimension; note that
the dimension is highlighted. Move the cursor slowly
until a small arrows marker appears next to the cursor,
as shown in the figure.

2. Drag with the left-mouse-button to reposition the
selected dimension.

3. Repeat the above steps to reposition the horizontal
dimension.
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Using the Measure Tools

Autodesk Inventor also provides several measuring tools that allow us to measure area,
perimeter and additional information of the constructed 2D sketches.

1. In the Inspect Ribbon tab, left-click once on the
Measure option as shown.

HD*BEQﬁ';fw' 4}
S5 3D Model Ann

=
Measure Region | Zebra Draft Surf
I}Pmperties
M ===
model x Measure (M)

e Note that other measurement options are also
available in the toolbar.

Qa 2. Click on the top edge of the rectangle as
shown.
Measure X+ =
v Selection 1 (Curve) 3. The associated length measurement of the
Length — selected geometry is displayed in the

Length dialog box as shown.

» Advanced Properties

4. Inside the graphics window, right-click once to bring up
the Option menu and select Restart as shown.

( Done [esc] B9 ) (# oK )
) ) 5. Move the cursor on top of any of the edges
|} Home View and click once with the right-mouse-button
—'—T_ = . -

(R select cheﬁ.. Ctri+A to bring up the Option menu and choose

| Restart Select Other... as shown.

E‘-: Previous View F5

L How To... ]
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|_|l(2 Curve Loop |~
T 6. In the Selection list, left-click once to pick the
2. Curve Loop Curve Loop option as shown.

Measure X +
¥ Selection 1 (Curve Loop)

Length 250.000 mm e The perimeter of the
rectangle is

¥ Advanced Properties displayed as shown.

Precision 3.123 -
250.000 rym Length
Angle Precision  2.12 v 9
| Dual Units Mone v

Measure + = . .
)E} 7. Click on the [X] icon to end the

¥ Selection 1 (Curve Loop) Measure command as shown.

Length 250.000 mm

¥ Advanced Properties

8. In the Inspect Ribbon tab, left-click once on the Region Properties option as
shown.

HD-EHS -~ B h- - % & Maeil -

3D Model Annotate  Inspect  Tools Manage View E

= [ g ABR4

Measure Region | Zebra Draft Surface Section Curvature Tolerance | Finish

Prupeﬂl} Analysis | Sketch

Measure R “!

Model X o | Region Properties |
B Parti Calculates one or more closed sketch loops you selectin a 2D

sketch.
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9. Click on the inside of the rectangle;
notice the region is highlighted as the
cursor is moved inside the rectangle, as
shown.

Dual Units
None v

o

10. In the Region Properties dialog box, click on the
Calculate button to perform the calculations of the
associated geometry information.

Region Properties X

7

Selections Dual Units ¢ In the Region Properties dialog box,
b sketch Loopt None ] the detailed region properties are
clektocd calculated and displayed, including the
Area Moments of Inertia, Area and
Area = 3750 mm~2 ~ Perimeter.

Perimeter = 250 mm

Centroid,with respect to Sketch Origin{mm)
X=38
Y =-12

11. Click Done to exit the Region
Properties command.

TInertia with respect to Sketch Origin{mm):

Inertia Tensor{mm~4)
Dx = 1347932
Ty = -1728687
Tyx = -1728687
Tyy = 7031250

Polar Moment of Inertia = 8379182 mm~4

Area Moments of Inertia with respect to Principal Axes(mm~4):
Ix = 781250

Tw — 1757812

b Inspect @ Tools Manage \View

v

e Section Curvature | Finish
Sketly
&%) Finish Sketch

12. Select Finish Sketch in the Ribbon to end the
Sketch option.

lysis

Exits the active
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Completing the Base Solid Feature
HDo-DHS - @Bk

3D Model  Sketch  Annotate |

o W 2o
— Loft &M
Start EItI‘D?E Revolve

2D Sketch ” . = Coil (i
Sketch Extrude (E)

Model %+ Creates a feature or body
profiles create solids or su

1. Inthe 3D Model tab select the Extrude
command by clicking the left-mouse-button
on the icon.

2. In the Extrude pop-up window, enter 15 as
the extrusion distance. Notice that the
sketch region is automatically selected as
the extrusion profile.

Partl

Properties X =
Extrusion > Sketchi 0o
v Input Geometry
Profiles k [ 1 Profile o
From k 7 1 Sketch Plane T
v Behavior
Directon o KK -
Distance A 15 mm 1
v Cutput
Body Name Solidl
» Advanced Properties

(o J[ e | [+

3. Click on the OK button to proceed with creating the 3D part. Use the Dynamic
Viewing options to view the created part. Press F6 to change the display to the
isometric view as shown before going to the next section.
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Creating the Next Solid Feature

D-EHw- -
File 3D Model  Sketch  Ami

7 @3
Sta.:h Extrude Revolve g
2D Sketch ™

Sketch
Model % 2D Sketch (5)

Creates a 20 sketch on a

1. Inthe 3D Model tab select the Start 2D Sketch
command by left-clicking once on the icon.

o

2. In the Status Bar area, the message “Select plane to create sketch or an existing
sketch to edit” is displayed. Autodesk Inventor expects us to identify a planar surface
where the 2D sketch of the next feature is to be created. Move the graphics cursor on
the 3D part and notice that Autodesk Inventor will automatically highlight feasible
planes and surfaces as the cursor is on top of the different surfaces.

3. Use the ViewCube to adjust the display viewing the bottom face of the solid model
as shown below.

4. Pick the bottom face
of the solid model.

4. Pick the bottom face of the 3D model as the sketching plane.

» Note that the sketching plane is aligned to the selected face. Autodesk Inventor
automatically establishes a User-Coordinate-System (UCS) and records its location
with respect to the part on which it was created.
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5. Select the Center Point Circle command by clicking
once with the left-mouse-button on the icon in the
Sketch tab.

Center Point Circle (Ctrl

Creates a circle using a c

6. Inside the graphics window, click once
with the right-mouse-button to bring
up the option menu and choose the snap
to Midpoint option.

7. Select the bottom edge of the base feature to align
the center point of the new circle.

8. Select the green dot to align the midpoint of the
line.

9. Select the bottom corner of the base feature
to create a circle as shown in the figure.

10. Inside the graphics window, click once with
the right-mouse-button to display the option
menu. Select OK to end the Circle

command.
-

| L Twa Point Reclangle_;;

<Ly

|l; % Project Geometry )

> [ v
L Finish

"':'-f“_: Show Format  § g3 h

11. In the Ribbon toolbar, select Finish Sketch to
exit the Sketch mode.

Format «
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12. Press the function key F6 once or select Home View in the
ViewCube to change the display to the isometric view as shown.

HD-FEHS = 5
3D Model = Sketch  Annotate
.1;;. T m"" ﬂ Sweep

Start Elctl:}de Revolve
2D Sketch ™

Sketch | Extrude (E)

13. In the 3D Model tab, select the Extrude
command by left-clicking the icon.

14. Autodesk Inventor next expects us to
select the region to be used to create the
feature. First select inside the semi-circle
region under the solid feature as shown.

15. Select inside the other semi-circle region
outside the solid feature as shown.

e Note that Autodesk Inventor creates the
extruded feature downward as shown.
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16. In the Extrude pop-up control, enter 40 as the blind extrusion distance as shown
below. Set the solid operation to Join and click on the Flip direction button to
reverse the direction of extrusion (upward) as shown below.

Properties X + =
L &
Extrusion > Sketchz Do

¥ Input Geometry
Profiles k [ 2 Profiles o

From k 47 1 Sketch P

Enter 40 A X -

Distance A 40 mm E L &

Join option

» Note that most of the settings can also be set through the icons displayed on the
screen.

17. Click on the OK button to proceed with the Join operation.

e The two features are joined together into one solid part; the CSG-Union operation
was performed.

CSG UNION




3-22 Autodesk Inventor and Engineering Graphics

Creating a Cut Feature

We will create a circular cut as the next solid feature of the design. We will align the
sketch plane to the top of the last cylinder feature.

HDo-EHS- -

3D Model ~ Sketch  An
g &
Sta-rlth Extrude Revolve g

2D Sketch 3

Sketch
Maodel 3

1. Inthe 3D Model tab select the Start 2D Sketch
command by left-clicking once on the icon.

2D Sketch (5)
Creates a 2D sketch on a

2. Pick the top face of the cylinder
as shown.

2. Pick the top face to
align the sketch.

Annotate  Inspect

3. Select the Center Point Circle command by clicking
once with the left-mouse-button on the icon in the
Sketch tab of the Ribbon toolbar.

Center Point Circle (Ctrl

Creates a circle using a ©

4. Select the Center point of the top face of
the 3D model as shown.
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5. Sketch a circle of arbitrary
size inside the top face of the
cylinder as shown to the left.

6. Use the right-mouse-button to
display the option menu and
select OK in the pop-up menu
to end the Circle command.

(3 Two Pont Rectange )

o - - i -. 2 = —a o i /
‘5 Project Geometry )

7. Inside the graphics window, click once with the
right-mouse-button to display the option menu.
Select the General Dimension option in the pop-up
menu.

9. Inside the graphics window, click once with the right-
mouse-button to display the option menu. Select OK in the
pop-up menu to end the Dimension command.

10. Inside the graphics window, click once with the right-
mouse-button to display the option menu. Select Finish
2D Sketch in the pop-up menu to end the Sketch
option.
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HD-FEHS = 5

3D Model = Sketch  Annotate

— T ﬁ ) Sweep

1/

i Loft
Start Elctl::g:le Revolve
2D Sketch = Coil

Sketch | Extrude (E)

11. In the 3D Model tab, select the Extrude
command by left-clicking on the icon.

12. Click on the inside of the sketched circle as the profile to be extruded.

propertes x| = || 13. In the Extrusion pop-up

Extruson® > Sketch®

window, set the operation
option to Cut. Select

¥ Input Geometry
Profiles k D 1 Profile

From A isecrae 1 Through All as the Extents
¥ Bohavior option, as shown below.
y o A N - Confirm the arrowhead points

pemmh | twem - L & downward.

¥ Qutput

Boolean & - - .

> Aot et | 14. Click on tt}e OK button to
o ) canca | + proceed with the Cut

i operation.

A
(

CSG Cut

The circular volume is removed
from the solid model; the
CSG-Cut operation resulted in
a single solid.
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Sketched Features vs. Placed Features

In Autodesk Inventor, there are two types of geometric features: placed features and
sketched features. The last cut feature we created is a sketched feature, where we
created a rough sketch and performed an extrusion operation. We can also create a hole
feature, which is a placed feature. A placed feature is a feature that does not need a
sketch and can be created automatically. Holes, slots, fillets, chamfers, and shells are all
placed features.

o
Hole Slot  Fillet g Shet
T (@ Draft

Placed Chamfer

Placed Hole
Feature

Placed Slot
Feature

Placed Fillet

Hole tool: Quickly place holes using presets, or specify the hole dimensions, drill point,
termination, and thread type options using the property panel.

Slot tool: Quickly place slots using presets, or specify the slot dimensions. Other
options, such as sharp corner, fillets, counter bore, counter sink options.

Fillet tool: Quickly place rounded corners, both curving inward and outward. Basic
option is done by selecting edges; more complicated options such as varying radii can
also be created.
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Creating a Placed Hole Feature

In Autodesk Inventor, there are two types of geometric features: placed features and
sketched features. The last cut feature we created is a sketched feature, where we
created a rough sketch and performed an extrusion operation. We can also create a hole
feature, which is a placed feature. A placed feature is a feature that does not need a
sketch and can be created automatically. Holes, fillets, chamfers, and shells are all placed
features.

nage View  Environments  Get Started
1. In the Create toolbar, select the Hole

@ D CTEMER | TS command by left-clicking on the icon.
() shet g Combin

Haolg Fillet
p % ﬂ‘ I La ﬂ b ol S i

Hole (H)

2. Pick a location inside the top horizontal
surface of the base feature as shown.

3. Enter 20 mm as the diameter of the hole as shown. Do Not click the OK button yet.

Properties X +
Hok®> sketchd”

LT

No Preset B
» Input Geometry

¥ Type

o TDMH W
= [olHnH

¥ Behavior
Termination T 1
Direction o 4

Enter 20 \LL

»‘ S a0mm

» Advanced Properties

e

+
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. Pick the right-edge of the top face of the

base feature as shown. This will be used as
the first reference for placing the hole on the
plane.

. Enter 30 mm as the distance as shown. Do

Not click the OK button yet.

. Pick the adjacent edge of the top face as

shown. This will be used as the second
reference for placing the hole on the plane.

. Enter 25 mm as the distance as shown.

. In Holes dialog box, set the Termination
option to Through All.

9. Click on the OK button to proceed with the Hole feature.

e The circular volume is removed from the solid model; the CSG-Cut operation

resulted in a single solid.

CSG Cut




3-28 Autodesk Inventor and Engineering Graphics

Creating a Rectangular Cut Feature

Next create a rectangular cut as the last solid feature of the Locator.

D-EHw- =

File 3D Model = Sketch  Ani

o @
Sta.rtb Extrude Revolve @
2D Sketch ™ =

Sketch
Model % 2D Sketch (5)

Creates a 2D sketch on a

1. Inthe 3D Model tab select the Start 2D Sketch
command by left-clicking once on the icon.

2. Pick the right face of the base feature as shown.

LG Annotate  Inspect  Tools  Manage

I < ] [ Fillet -
- |
Q / |— A Text - 3. Select the Two point rectangle
Circle  Arc  Rectangle command by clicking once with the
N N 7 -+ Point G left-mouse-button on the icon in the

Sketch tab of the Ribbon toolbar.

Two Point Rectangle

4. Create a rectangle that is aligned to the top and I:
bottom edges of the base feature as shown. (Hit [F6]
to set the display orientation if necessary.)

5. On your own, create and modify the two dimensions as
shown.

=
A Finish

E’E Show Format S ¢ h

6. Select Finish Sketch in the Ribbon toolbar to
end the Sketch option.

Format «
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HDo-DH<-~ 2B

File 30 Model  Sketch  Annotate

i 17 i T ﬁ ) sweep[| 7. In the 3D Model tab, select the Extrude
- W Loft command by left-clicking on the icon.
Start Extl:}de Revolve

2D Sketch Coil
Sketch Extrude (E)

8. In the Extrude pop-up window, the Profile button is pressed down; Autodesk
Inventor expects us to identify the profile to be extruded. Move the cursor inside the
rectangle we just created and left-click once to select the region as the profile to be
extruded.

Properties X + =
(]
Eii Sk Do

9. In the Extrude pop-
up window, set the
operation option to
Cut. Select To
Next as the Distance
option as shown. Set
the arrowhead points
toward the center of
the solid model.

v Input Geometry
Profiles & D 1 profile Ld

(]
From k 7 1Sketch Plane |

¥ Behavior

Direction Pl X
Distance A (oomm) » F L @
To Next & 150ld
¥ Output

Boolean A

“"1| » Advanced Properties

(I

10. Click on the OK
button to create the
Cut feature and
complete the design.
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Save the Model

n 3~ <=t @1 Select Save in the Quick Access Toolbar, or you
ST 30 Model - Slketeh Ann can also use the “Ctrl-S” combination (hold down
P—— Save (Ctrl+5) b s the “Ctrl” key and hit the “S” key once) to save
| lJ_l_ | gy - the part.
L
Start Extrude Revolve . . . L
70 Sketch = c{ 2. Switch to the Parametric Modeling folder if it
Sketch is not the current folder.

3. In the Save 4s dialog box, right-click once in the /ist area to bring up the option

menu.
View 3
Sort by v | 4. In the option list, select New as shown.
Group by »
Refresh 5. In the second option list, select Folder to create a
Paste subfolder.
Paste shortcut |, Folder
Share with » td Shurtcup
New b Microsoft Access Database
I} Bitmap image

Properties

Savein: | |. Parametric-Modeling -
N 6. Enter Chapter3 as the new folder
Name name as shown.
! Chapter2
. OldVersions 7. Double-click on the Chapter3 folder
| j,l Chapter3 | to open it.

8. In the file name editor box, enter Locator as the file name.

4| m

File: name: Locator] - |

Save as type: [Mﬂd&d{hfﬂai’mrﬂ.}_ ']

9. Click on the Save button to save the file.
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Review Questions: (Time: 20 minutes.)

I.

7.

List and describe three basic Boolean operations commonly used in computer
geometric modeling software.

What is a primitive solid?
What does CSG stand for?
Which Boolean operation keeps only the volume common to the two solid objects?

What is the main difference between a CUT feature and a HOLE feature in Autodesk
Inventor?

Create the following 2D Sketch and measure the associated area and perimeter.

&0

R2.5

Using the CSG concepts, create Binary Tree sketches showing the steps you plan to
use to create the two models shown on the next page:
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Exercises: Create and save the exercises in the Chapter3 folder.
(Time: 180 minutes.)

1. Latch Clip (Dimensions are in inches. Thickness: 0.25 inches.)

£.50

=~—1.50 3.50

1.00— —] 100 |

100 -

-—1,75——‘

275

- 475 -

2. Guide Plate (Dimensions are in inches. Thickness: 0.25 inches. Boss height 0.125
inches.)

425

81,00
\( #1.00

1,00

I

3.00

3.30
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3. Angle Slider (Dimensions are in Millimeters.)

4. Coupling Base (Dimensions are in inches.)
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5. Indexing Guide (Dimensions are in inches.)
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7. Slide Base (Dimensions are in inches.)
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Notes:
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